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Not everything is fun and games on your Ubuntu workstation. There are a few things 
you should do to help ensure that your system is running properly. There are also 

times when things go wrong. When that happens, it helps to know how to look at various 
parts of your system and see what’s going on. This chapter walks through some of the 
basics of managing your Ubuntu workstation. It discusses how to use the simple utilities 
Ubuntu provides for interacting with your system and determining how it’s doing. 

First we’ll take a look at the System Monitor, which can provide some excellent information 
about what programs are running and how much of the system resources they’re using. 
We’ll then take a look at how Ubuntu uses log files to document when things go wrong on 
the system. Next, we’ll look at a couple of utilities that Ubuntu provides for configuring 
which system services and applications run, both when your system starts and when you 
log into your desktop. Finally, we’ll discuss the Disk Usage Analyzer tool, which allows 
you see where your disk space is going.

Monitoring the System
The best tool for administering your Ubuntu workstation is the System Monitor. Start the 
System Monitor by selecting System ➪ Administration ➪ System Monitor from the Panel 
menu. The System Monitor tool provides information about how the system hardware and 
software are working.

There are four window tabs of information in the System Monitor:

System:♦♦  Displays general information about the Ubuntu workstation.
Processes:♦♦  Shows real-time information about programs currently running on 
the system.
Resources:♦♦  Shows real-time information about CPU and memory usage.
File Systems:♦♦  Shows information about the hard drives that are mounted on the 
system.

Of course, just having a bunch of information thrown at you doesn’t help at all. For that 
information to be useful, you need to know what it means. The following sections help 
you interpret the various pieces of information contained in the System Monitor.

System
The System tab provides an easy, one-stop-shopping location to find basic information 
about the system. There are three sections in the System tab:

Ubuntu:♦♦  Provides information on the version of Ubuntu installed, the Linux kernel 
version, and the GNOME desktop version.
Hardware:♦♦  Displays the processor type and the amount of physical memory 
installed in the system.
System Status:♦♦  Displays the amount of disk space available on the system.

Although not a major source of information, the System tab does provide some of the basic 
things you might be curious to know about your Ubuntu system, or might need to know if 
you stumble across another Ubuntu system and need to know what it’s running.
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Processes
In the Linux world, processes are the programs running on the system. It often helps to 
know what processes are running on the Ubuntu system, especially because many of 
them run in background mode. Processes running in background mode don’t appear on 
your desktop, so you have no way of knowing they’re running. These programs perform 
most of the behind-the-scenes work, such as monitoring the battery level in your laptop 
and scheduling programs to run at specific times.

Clicking the Processes tab provides an overview of the programs currently running on 
the system, as shown in Figure 18-1.

Figure 18-1: The Processes tab in the System Monitor tool.

Processes appear in a table format in the window display. The default view shows all pro-
cesses currently being run by your user account. Alternatively, you can watch all of the 
processes running on the system, or just the ones that are actively working, by clicking 
the View menu item from the menu bar and selecting which option you want to view.

Selecting the Dependencies entry in the View menu reorders the process list to show 
which processes started which other processes. This option produces a drop-down tree, 
with parent processes at the top level and, below that, any child processes that the parent 
started. You can roll up the children processes and display only the parent processes by 
clicking the arrow icon next to the parent process.

You can sort the process rows in the list based on any of the table columns. For example, to 
see what processes are using the largest percentage of CPU time, click the % CPU column 
heading. The System Monitor automatically sorts the rows based on percentage of CPU 
usage. Clicking the column heading a second time reverses the order of the list.
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You can customize the table by adding or removing data columns for the processes. Click 
Edit ➪ Preferences with the Processes tab selected to see the options available for the 
Processes tab. Table 18-1 lists the data available to display in the Processes tab table.

Table 18-1: System Monitor Process Table Columns

Column Description

Process Name The program name of the running process

User The owner of the process

Status The status (either sleeping or running) of the process

Virtual Memory The amount of virtual system memory allocated for the process

Resident Memory The amount of physical memory allocated for the process

Writable Memory The amount of memory allocated to the process currently loaded into 
physical memory (active)

Shared Memory The amount of memory shared between this process and other processes

X-Server Memory The amount of memory the process shares with the X Windows (GUI) 
server

% CPU The percentage of total CPU time the process is using

CPU Time The actual CPU time the process is using

Started The time the process started running

Nice The system priority of the process (higher nice numbers have lower prior-
ity on the system)

ID The unique process ID (PID) the system assigned to the process

Security Context The security classification assigned by the SELinux security system

Command Line The name of the command and any command-line arguments used to 
start it

Memory The amount of system memory the process is using

There are also a few other options you can set while you’re in the Properties dialog box 
of the Processes tab:

Update Interval in Seconds:♦♦  Specifies how frequently the System Monitor 
refreshes the process table data.
Enable Smooth Refresh:♦♦  Gathers new process information before refreshing 
the process table data, rather than refreshing table data as it gathers process 
information.
Alert Before Ending or Killing Processes:♦♦  Produces a warning that you are about 
to terminate a running process.
Solaris Mode:♦♦  Calculates the percentage of CPU utilization based on the number 
of active CPU cores. Thus, if two separate processes are maxing out two separate 
CPU cores, they would both show 50 percent CPU utilization instead of both 
showing 100 percent.
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You can also control processes that you own from the Processes tab. Right-clicking a 
process produces a menu that allows you to stop, end, or kill a process, along with entries 
that allow you to change the priority of the process.

Resources
Clicking the Resources tab provides a quick graphical overview of the hardware status 
of the system, as shown in Figure 18-2.

Figure 18-2: The Resources tab in the System Monitor tool.

There are three graphs displayed:

CPU History:♦♦  Displays the running real-time CPU percentage utilization. If the 
system contains more than one processor, each processor is shown as a separate 
history line.

The System Monitor allows you to stop only the processes that you own. These 
are processes that your desktop started when you logged in and any programs 
or applets that you run from your desktop environment. Unfortunately, it doesn’t 
tell you that. It’ll allow you to select a process that you don’t own and click the End 
Process button. However, the attempt to end a process you don’t own will fail.

To stop system processes you must have administrative privileges (see Chapter 17, 
“Users and Groups”).
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Memory and Swap History:♦♦  Displays two running real-time graphs, one for the 
amount of memory used by the user and one for the amount of swap space used 
by the user.
Network History:♦♦  Displays the amount of data sent and received from the net-
work interfaces.

Each graph displays the values for the last minute of operation, starting with the current 
time on the right side of the graph. The Resources tab can give you a quick overall picture 
of how your system is doing. If you see that the CPU or memory usage is running high, 
you can flip over to the Processes tab and sort the list based on that parameter.

Besides the graphical view, the Resources tab displays the current real-time informa-
tion for each value, under the graph. The CPU History displays the current CPU load as 
a percentage of the CPU capacity. The Memory and Swap History displays the physical 
and swap memory areas used, as a pie chart icon. The more memory or swap space used, 
the more of the icon is filled. The Network History displays both the sent and received 
data on the network interfaces. It displays graphs of the current KB/s data flow on the 
network interfaces, as well as a numerical value of the total data sent and received since 
the system was started.

File Systems
Clicking the File Systems tab gives you a quick look at the amount of disk space used on 
each mounted filesystem, shown in Figure 18-3.

Figure 18-3: The File Systems tab in the System Monitor tool.

All hard drives and partitions mounted on the Ubuntu system are shown, along with their 
total disk space, free disk space, and used disk space. This tab gives you a quick indica-
tion of how much free space you have left on your hard drive.
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Log Files
An important part of Ubuntu system administration is knowing what’s happening on the 
system. Because there’s so much activity happening behind the scenes, it’s often hard 
to keep tabs on your workstation. Fortunately, Ubuntu provides a relatively easy way for 
you to look at what’s happening on the system. This section walks through the use of log 
files and explains how to easily view them all from one location.

Ubuntu Log Files
Ubuntu provides several levels of log files for the system. Log files are used by processes 
to track errors, warnings, and general items of information that may be important. It’s 
usually a good idea to take a peek at the log files on a regular basis to see what’s hap-
pening on the system.

The process that controls logging on the Ubuntu system is syslogd. The syslogd process 
runs in the background and directs log messages from applications and the Linux ker-
nel to different log files. Because there’s so much activity going on, Ubuntu uses several 
different log files to track different features of the system. All of the log files are stored 
in the /var/log directory on the Ubuntu system. Table 18-2 describes the different log 
files in that folder.

Table 18-2: The Ubuntu Log Files

Log File Description

auth.log System authentication events, such as login attempts

daemon.log Background process events

kern.log Linux kernel events

messages Standard system and application events

syslog System errors

user.log User events

Xorg.0.log X Window system events

You’ll notice that there’s a phantom entry in the File Systems devices, called 
gvfs-fuse-daemon. This is the GNOME Virtual File System (GVFS). The GVFS 
acts as a proxy to the real filesystem, translating read and write requests from a 
real mounted device and the GVFS object. The main purpose of GVFS is to allow 
normal system users to mount filesystems, especially removable filesystems such 
as USB Memory Sticks and CD-ROMs.

The GVFS simulates the root filesystem in the user’s home folder so that any 
attempts to mount a media device can be made in the user’s home folder area 
with the user’s privileges instead of requiring root privileges. This crucial feature 
of the GNOME desktop allows normal system users to use removable media.
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Fortunately, you don’t have to hunt for each of these log files individually. Ubuntu provides 
a handy utility that helps manage all of the log files from a single graphical interface.

The System Log Viewer
The System Log Viewer is a utility in the Administration menu (select System ➪ 
Administration ➪ System Log from the Panel menu). It allows you to quickly view all of 
the configured log files from a single location. Figure 18-4 shows the main System Log 
Viewer window.

The System Log Viewer window has three sections:

The log file list:♦♦  Lists the log files available to view. Log files with data that have 
been added since the System Log Viewer was started appear in bold.
The calendar: ♦♦ Allows you to select a day from the log files to view. Ubuntu cre-
ates a new version of each log file each day. You can view any of the available 
daily log files by selecting the date in the calendar. Days with available log files 
appear in bold.
The log viewer:♦♦  Displays the contents of the selected log file.

The System Log Viewer uses monitored mode to watch the log files in real-time. This 
mode notifies you of new log file entries by displaying the log filename in bold in the log 
file list and making the new entries appear in bold in the log viewer. If your system is 
experiencing a problem that is quickly filling up the log file, you can disable monitored 
mode by selecting View ➪ Monitor from the menu bar.

The log files used by the syslogd process are defined in the /etc/syslog.conf 
file. This file defines what type of log entries are stored in which log files.

Log entries are classified by a tiered system, from lowest to highest priority:

debug: application debugging messages•	
info: informational messages•	
notice: event notices from applications•	
warning: minor error messages•	
err: an error condition in an application•	
crit: a critical system error•	
alert: a system error that requires immediate action•	
emerg: an error that prevents the system from running•	

Some Linux distributions provide a single log file for handling critical and alert 
messages, but Ubuntu doesn’t use this technique. Instead, it separates log mes-
sages by source and importance.

For example, you’ll find four log files for logging mail activity on the Ubuntu 
system: mail.error, mail.info, mail.log, and mail.warn. Each log file 
contains messages for the specified log level for the mail system.

95080c18.indd   432 2/17/09   1:24:16 AM



 Chapter 18: Basic Administration 433

Figure 18-4: The main System Log Viewer window.

Starting Services
If you have administrative privileges, the Services Settings dialog box allows you to set 
which system programs start when you boot the Ubuntu workstation. This feature pro-
vides an easy interface for controlling system programs on your Ubuntu system without 
having to go to the command line.

This section discusses how you can control system services from the Services Settings 
dialog box.

Starting and Stopping Services
To start the Services Settings dialog box, select System ➪ Administration ➪ Services 
from the Panel menu. Figure 18-5 shows the main Services Settings dialog box.

Figure 18-5: The Services Settings dialog box.
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As you can see from Figure 18-5, there’s not much to the Services Settings dialog box. 
It lists the services you can control, with a check box for each service. The services that 
are already set to start when the system boots have a check mark in the box. You can set 
the service to not start at boot time by unchecking the box.

Similarly, you can select a new service to start at boot time by checking its box. The 
Ubuntu system adds the service to the list to start when the system boots. If it was suc-
cessful, the check mark remains in the box. If it wasn’t successful in setting the service, 
the check mark disappears. If that happens, you’ll need to look at the messages log file 
using the System Log Viewer (discussed earlier, in the “Log Files” section of this chapter) 
to find any error messages indicating why the service couldn’t start.

Table 18-3 shows the services you can control from the Services Settings dialog box.

Table 18-3: The Services Settings Dialog Box Services

Service Name Description

anacron Actions scheduler Schedules background processes for future days

atd Actions scheduler Schedules background processes for a later time in 
the same day

alsa-utils Audio settings manager Provides a common software interface for audio 
hardware

apport Automated crash reports 
support

Debugging tool for producing reports when the 
system crashes

bluetooth Bluetooth device manager Interfaces with Bluetooth devices

britty Braille display manager Interfaces with Braille reading devices

klogd Kernel event logger Logs events from the Linux kernel

syslogd Application activity logger Logs events from processes running on the system

powernowd CPU frequency manager Controls the speed of the processor to conserve 
power on laptops

gdm Graphical login manager Provides the graphical login screen

hotkey-setup Hotkeys manager Detects type of keyboard in use and configures 
special keys

avahi-daemon Multicast DNS service 
 discovery

Detects devices on the network

acpid Power management Uses the Advanced Configuration and Power Inter-
face to query and control battery life

apmd Power management Uses the Advanced Power Management system to 
query and control battery life

dbus System communica-
tion bus

Provides a communications channel for 
 applications to send and receive messages

The Ubuntu boot process is somewhat complicated because not all services start at the 
same time when you boot. You can define when specific services start, using the Properties 
feature of the Services Settings dialog box, discussed next.
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Service Properties
Right-clicking on a service name in the Services Settings dialog box and selecting 
Properties displays the startup options for the service, as shown in Figure 18-6.

Figure 18-6: The Service Properties dialog box.

The Service Properties dialog box contains three columns of information:

Runlevel:♦♦  the operating mode level of the system
Status:♦♦  what state the service should be at
Priority:♦♦  the priority level the system should assign the service

The runlevel defines a mode of operation in a Linux system. Ubuntu is configured to start 
different types of applications when it enters different runlevels. Table 18-4 displays the 
runlevels available in Ubuntu.

Table 18-4: The Ubuntu Runlevels

Runlevel Description

0 Halt the system

1 Start all system services but allow only a single user to log in

2-5 Start all system services, plus the graphical desktop environment

6 Reboot the system

The Ubuntu workstation usually runs at runlevel 5, which starts all of the system services 
and the graphical desktop. You’ll notice that the properties for each service are the same 
for runlevels 2 through 5. Ubuntu doesn’t differentiate among these runlevels.

The status defines what state the service should be in:

Ignore:♦♦  Don’t worry about the service at this runlevel.
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Start:♦♦  Attempt to start the service at this runlevel.
Stop:♦♦  Attempt to stop the service at this runlevel.

If you look at the status values in Figure 18-6, you’ll notice that when the system is at run-
level 0 or 6, Ubuntu ignores the services. At runlevel 1, most of the services are stopped 
to allow the single user (the administrator) to log in and maintain the system. All of the 
services are started at runlevels 2 through 5.

The priority determines the order in which the system should start or stop services when 
the system enters the runlevel. This value is a number from 1 to 100, with 100 meaning 
that a service is a high priority and 1 meaning the service is a low priority. A value of 
–1 indicates that the service priority doesn’t matter—the system can handle the service 
whenever possible.

Sessions
Although the Services Settings dialog box handles system services, it doesn’t help out 
with the normal system processes that need to run. The Sessions Preferences dialog box 
helps you there.

Selecting System ➪ Preferences ➪ Sessions from the Panel menu starts the Sessions 
Preferences dialog box, shown in Figure 18-7. This interface allows you to control what 
programs run in your specific session.

Figure 18-7: The Sessions Preferences dialog box.

There are two tabbed windows in the dialog box:

Startup Programs:♦♦  Displays applets and programs that you’ve configured to start 
up when you log into the system.
Options:♦♦  Allows you to set your session to automatically start any applications 
that are running when you log out and back in.

This section walks through how to control your session preferences using this utility.
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Startup Programs
The Startup Programs list displays all of the applets and programs that you’ve config-
ured in your desktop session to run automatically. This display includes any applets that 
you’ve added to your panel (see Chapter 4, “Exploring the Desktop”), such as the Network 
Manager applet, the Update Notifier, and the Volume Manager.

From this interface you can temporarily disable an applet or program from starting simply 
by removing the check mark from the Enabled check box. This action keeps the applet 
or program available to start later if you want—it just prevents it from starting the next 
time you log into the system.

You can completely remove an applet or program from the startup list by selecting the 
entry in the list and clicking the Remove button. Also, you can edit the settings an applet 
or program starts with by clicking the Edit button. The Edit Startup Program dialog box 
allows you to set command-line parameters used when starting the application, as shown 
in Figure 18-8.

Figure 18-8: The Edit Startup Program dialog box.

Once you remove a startup applet or program from the session, it won’t start for any sub-
sequent sessions.

Options
The Options tab provides a way for you to save your existing sessions. The check box 
titled Automatically Remember Running Applications When Logging Out pretty much 
does what it says. It saves the currently running applications in the session manager when 
you log out and automatically starts them the next time you log in.

If you prefer to have specific applications automatically start, you can start the applica-
tions, then click the Remember Currently Running Applications button. This option saves 
all of the applets and programs currently running on the desktop in the session manager 
and attempts to start them every time you log into the system.
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Disk Usage Analyzer
Disk space usage is one of the hardest things to manage on an Ubuntu system. With 
applications getting larger and digital multimedia becoming more popular, there never 
seems to be enough disk space available to do everything you want.

The problem with running out of disk space is that often you don’t have a clue as to what 
caused the problem. With just the Nautilus file-browsing tool, you can’t easily tell where 
all of the disk space is being used. Fortunately, Ubuntu provides a graphical tool to help 
you determine where all your disk space is going.

The Disk Usage Analyzer tool provides a quick and easy way to examine the layout of 
your Ubuntu filesystem and identify areas where disk usage is great. To start the Disk 
Usage Analyzer tool, click Applications ➪ Accessories ➪ Disk Usage Analyzer. The main 
window, shown in Figure 18-9, appears.

Figure 18-9: The Disk Usage Analyzer tool.

The main window displays the current state of the Ubuntu filesystem. The window dis-
plays the filesystem summary information at the top (the total amount of disk space in 
the complete filesystem, the amount used, and the amount available). If the filesystem 
contains multiple partitions, this window summarizes the totals of all of the partitions 
used in the filesystem.

The left side of the main window displays a graphical bar indicating the percentage of 
the filesystem disk space used, along with the numeric total. The right side of the main 
window displays a treemap of the results. A treemap graphically displays the hierarchy 
of each folder in the system. The default treemap shows the filesystem as a whole.
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To perform a detailed analysis of your system, select one of the four scanning buttons in 
the toolbar:

Scan Home:♦♦  to analyze the folders contained in your home folder
Scan Filesystem:♦♦  to analyze the entire filesystem
Scan Folder:♦♦  to single out a folder to analyze
Scan Remote Folder:♦♦  to scan a remote filesystem

Be careful when selecting to scan the entire filesystem or a remote filesystem. Analyzing 
the disk space requires reading the entire disk area. This process can take some time, 
depending on the size of the disk and, in the case of a remote scan, network connectivity 
speeds.

The result of a complete scan is shown in Figure 18-10.

Figure 18-10: A complete disk scan analysis.

The treemap view can seem confusing at first, but once you get the hang of it you’ll see 
that you can glean quite a bit of information from the treemap.

The treemap works from the core of the diagram outward. The core represents the top 
level of the tree. In my example, because I performed a home scan, the core is my home 
folder, /home/rich. If you hover the mouse pointer over the core, it shows the name of the 
folder and the amount of disk space used by that folder.

The next layer of rings depicts the next level of folders. In my home folder I have three 
subfolders. Each subfolder is a section of the first-layer ring, and its size is relative to the 
amount of used disk space in that subfolder.

The second layer of rings relate to the first layer. If there are subfolders beneath a subfolder, 
they appear in the second layer of rings, above their parent folder. Again, each folder in 
the second layer has a size relative to the amount of disk space it uses.

95080c18.indd   439 2/17/09   1:24:16 AM



 440 Part 3: Managing Your Workstation

This process continues for however many subfolders are contained in the filesystem being 
analyzed. You can quickly spot areas that use the most disk space by looking at the rela-
tive size of the ring sections (you can compare ring section sizes only on the same layer). 
This tool provides a great way to see at a glance where all of your disk space is going!

Summary
This chapter discussed some of the system administration utilities provided in the Ubuntu 
workstation. The System Monitor allows you to monitor and control processes running 
on the system, as well as view the current CPU, memory, network, and disk utilization 
on that system.

The System Log Viewer provides an easy way to view all of the log files available in the 
Ubuntu workstation from a single window. You can view those log files, plus look at the 
daily log files from separate days that are stored on the system.

The Services Settings window allows you to view and change which system services are 
started when the system boots. You can select which services start, what system runlevel 
they start in, and the priority (order) in the runlevel that they start.

Separate from the Services Settings window, the Sessions Preferences window allows 
you to configure the individual applets and programs that automatically start when you 
log into your desktop. The Sessions Preferences window provides options for selecting 
which applets and programs start, for viewing which applets and programs are currently 
running in your session, and for saving your session settings so that the same applets and 
programs start the next time you log in.

The last section of this chapter discussed how to use the Disk Usage Analyzer tool. This 
tool helps you identify the areas in a filesystem that use the most amount of disk space. 
The Disk Usage Analyzer scans a disk area (or the entire disk) and provides a graphical 
treemap of the results. Each ring on the treemap represents a folder level in the filesystem 
hierarchy. Folders at the same level in the same ring are depicted with sizes relative to 
the amount of disk space they use. 

In the next chapter we’ll take a look at the Ubuntu command line. The command-line 
interface can come in handy when trying to administer your system because it’s often 
quicker to enter commands than to interact with a graphical tool.
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